Windows Help
HP Deskjet F2400 All-in-One series
Contents

1 How Do I?................................................................................................................................3

2 Get to know the HP All-in-One
   Printer parts.........................................................................................................................5
   Control panel features.........................................................................................................6

3 Print
   Print documents..................................................................................................................7
   Print photos..........................................................................................................................8
   Print envelopes....................................................................................................................10
   Print on specialty media.....................................................................................................11
   Print a Web page..................................................................................................................17

5 Scan
   Scan to a computer............................................................................................................27

6 Copy
   Copy documents or photos.................................................................................................29

7 Work with cartridges
   Check the estimated ink levels..........................................................................................31
   Order ink supplies.............................................................................................................31
   Automatically clean print cartridges................................................................................32
   Manually clean print cartridges.........................................................................................33
   Replace the cartridges.......................................................................................................34
   Use ink-backup mode........................................................................................................36
   Cartridge warranty information.........................................................................................36

8 Solve a problem
   HP support.........................................................................................................................39
   Setup troubleshooting.........................................................................................................40
   Print troubleshooting..........................................................................................................44
   Scan troubleshooting.........................................................................................................48
   Copy troubleshooting.........................................................................................................50
   Errors.................................................................................................................................51

10 Technical information
   Notice.................................................................................................................................57
   Specifications......................................................................................................................57
   Environmental product stewardship program...................................................................58
   Regulatory notices............................................................................................................61

Index..................................................................................................................................65
1 How Do I?

Learn how to use your HP All-in-One

- “Copy documents or photos” on page 29
- “Load media” on page 23
- “Replace the cartridges” on page 34
## 2 Get to know the HP All-in-One

- **Printer parts**
- **Control panel features**

### Printer parts

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Control panel</td>
</tr>
<tr>
<td>2</td>
<td>Attention light</td>
</tr>
<tr>
<td>3</td>
<td>Check cartridge lights</td>
</tr>
<tr>
<td>4</td>
<td>Front access door</td>
</tr>
<tr>
<td>5</td>
<td>Paper-width guide for the main input tray</td>
</tr>
<tr>
<td>6</td>
<td>Input tray</td>
</tr>
<tr>
<td>7</td>
<td>Paper tray extender (also referred to as the tray extender)</td>
</tr>
<tr>
<td>8</td>
<td>Cartridges</td>
</tr>
<tr>
<td>9</td>
<td>Glass</td>
</tr>
<tr>
<td>10</td>
<td>Lid backing</td>
</tr>
<tr>
<td>11</td>
<td>Rear access door</td>
</tr>
<tr>
<td>12</td>
<td>Rear USB port</td>
</tr>
<tr>
<td>13</td>
<td>Power connection (Use only with the power adapter supplied by HP.)</td>
</tr>
<tr>
<td>14</td>
<td>Lid</td>
</tr>
</tbody>
</table>
Control panel features

1 **On**: Turns the product on or off. When the product is off, a minimal amount of power is still used. To completely remove power, turn off the product, then unplug the power cord.

2 **Cancel**: Stops the current operation.

3 **Start Copy Black**: Starts a black-and-white copy job.

4 **Start Copy Color**: Starts a color copy job.

5 **Attention light**: Shows attention event, such as paper jam or out of paper.

6 **Ink attention light**: Indicates low ink or a print cartridge problem.
3 Print

Choose a print job to continue.

“Print documents” on page 7

“Print photos” on page 8

“Print envelopes” on page 10

“Print on specialty media” on page 11

“Print a Web page” on page 17

Related topics
• “Load media” on page 23
• “Recommended papers for printing” on page 21

Print documents

To print from a software application
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. If you need to change settings, click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.

NOTE: When printing a photo, you must select options for the specific photo paper and photo enhancement.
5. Select the appropriate options for your print job by using the features available in the Advanced, Printing Shortcuts, Features, and Color tabs.

![Tip: You can easily select the appropriate options for your print job by choosing one of the predefined print tasks on the Printing Shortcuts tab. Click a type of print task in the Printing Shortcuts list. The default settings for that type of print task are set and summarized on the Printing Shortcuts tab. If necessary, you can adjust the settings here and save your custom settings as a new printing shortcut. To save a custom printing shortcut, select the shortcut and click Save As. To delete a shortcut, select the shortcut and click Delete.]

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

Related topics
- “Recommended papers for printing” on page 21
- “Load media” on page 23
- “View the print resolution” on page 19
- “Use printing shortcuts” on page 19
- “Set the default print settings” on page 20
- “Stop the current job” on page 55

Print photos

To print a photo on photo paper
1. Remove all paper from the input tray, and then load the photo paper print side down.

![Image of a printer with photo paper loaded]

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, select the appropriate photo paper type from the Paper Type drop-down list.
7. In the **Resizing Options** area, click the appropriate paper size from the **Size** list. If the paper size and paper type are not compatible, the product software displays an alert and allows you to select a different type or size.

8. In the **Basic Options** area, select a high print quality, such as **Best**, from the **Print Quality** drop-down list.

   **NOTE:** For maximum dpi resolution, go to the **Advanced** tab, and then select **Enabled** from the **Maximum dpi** drop-down list. For more information, see "Print using the maximum dpi" on page 18.

9. Click **OK** to return to the **Properties** dialog box.

10. (Optional) If you want to print the photo in black and white, click the **Color** tab and select the **Print in grayscale** check box. From the drop-down list, select one of the following options:

    • **High Quality**: uses all the available colors to print your photo in grayscale. This creates smooth and natural shades of gray.

    • **Black Ink Only**: uses black ink to print your photo in grayscale. The gray shading is created by varying patterns of black dots, which might result in a grainy image.

11. Click **OK**, and then click **Print** or **OK** in the **Print** dialog box.

   **NOTE:** Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.

---

**To print a borderless image**

1. Remove all paper from the paper tray.

2. Place the photo paper print side down on the right side of the paper tray.

3. On the **File** menu in your software application, click **Print**.

4. Make sure the product is the selected printer.

5. Click the button that opens the **Properties** dialog box. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer**, or **Preferences**.

6. Click the **Features** tab.

7. In the **Size** list, click the size of photo paper loaded in the paper tray. If a borderless image can be printed on the specified size, the **Borderless printing** check box is enabled.
8. In the **Paper Type** drop-down list, click **More**, and then select the appropriate paper type.

   **NOTE:** You cannot print a borderless image if the paper type is set to **Plain paper** or to a type of paper other than a photo paper.

9. Select the **Borderless printing** check box if it is not already checked. If the borderless paper size and paper type are not compatible, the product software displays an alert and allows you to select a different type or size.

10. Click **OK**, and then click **Print** or **OK** in the **Print** dialog box.

   **NOTE:** Do not leave unused photo paper in the paper tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.

**Related topics**
- “**Load media**” on page 23
- “**Print using the maximum dpi**” on page 18
- “**View the print resolution**” on page 19
- “**Use printing shortcuts**” on page 19
- “**Set the default print settings**” on page 20
- “**Stop the current job**” on page 55

**Print envelopes**

You can load one or more envelopes into the input tray of the HP All-in-One. Do not use shiny or embossed envelopes or envelopes that have clasps or windows.

   **NOTE:** For specific details on how to format text for printing on envelopes, consult the help files in your word processing software. For best results, consider using a label for the return address on envelopes.

**To print envelopes**

1. Slide the paper guide all the way to the left.
2. Place the envelopes in the right side of the tray. The side to be printed on should face down. The flap should be on the left side.
3. Push the envelopes into the printer until they stop.
4. Slide the paper guide firmly against the edge of the envelopes.
5. Open the **Printer Properties** dialog box.
6. Click the **Features** tab, and then select the following print settings:
   - **Paper Type**: Plain paper
   - **Size**: An appropriate envelope size
7. Select any other print settings that you want, and then click **OK**.

**Related topics**
- “Load media” on page 23
- “View the print resolution” on page 19
- “Use printing shortcuts” on page 19
- “Set the default print settings” on page 20
- “Stop the current job” on page 55

### Print on specialty media

#### Print transparencies
1. Slide the paper guide all the way to the left.
2. Place the transparencies in the right side of the tray. The side to be printed should face down and the adhesive strip should face up and toward the printer.
3. Carefully push the transparencies into the printer until they stop, so that the adhesive strips do not catch on one another.
4. Slide the paper guide firmly against the edge of the transparencies.
5. Open the **Printer Properties** dialog box.
6. Click the **Printing Shortcuts** tab.
7. In the **Printing Shortcuts** list, click **Presentation Printing**, and then specify the following print settings:
   - **Paper Type**: Click **More**, and then select an appropriate transparency film.
   - **Paper Size**: An appropriate paper size
8. Select any other print settings that you want, and then click **OK**.
Print postcards
1. Slide the paper guide all the way to the left.
2. Place the cards in the right side of the tray. The side to be printed on should face down and the short edge should point toward the printer.
3. Push the cards into the printer until they stop.
4. Slide the paper guide firmly against the edge of the cards.

5. Open the Printer Properties dialog box.
6. Click the Features tab, and then specify the following print settings:
   • Paper Type: Click More, click Specialty Papers, and then select an appropriate card type.
   • Print Quality: Normal or Best
   • Size: An appropriate card size
7. Select any other print settings that you want, and then click OK.

Print labels
1. Slide the paper guide all the way to the left.
2. Fan the edges of the label sheets to separate them, and then align the edges.
3. Place the label sheets in the right side of the tray. The label side should face down.
4. Push the sheets into the printer until they stop.
5. Slide the paper guide firmly against the edge of the sheets.

6. Open the Printer Properties dialog box.
7. Click the Printing Shortcuts tab.
8. In the Printing Shortcuts list, click General Everyday Printing, and then specify the following print settings:
   • Paper Type: Plain Paper
   • Paper Size: An appropriate paper size

9. Click OK.

Print brochures
1. Slide the paper guide all the way to the left.
2. Place the paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.

5. Open the Printer Properties dialog box.
6. Click the Features tab.
7. Specify the following print settings:
   • Print Quality: Best
   • Paper Type: Click More, and then select an appropriate HP inkjet paper.
   • Orientation: Portrait or Landscape
   • Size: An appropriate paper size
   • Two-sided printing: Manual
8. Click OK to print.

Print greeting cards
1. Slide the paper guide all the way to the left.
2. Fan the edges of the greeting cards to separate them, and then align the edges.
3. Place the greeting cards in the right side of the tray. The side to be printed on should face down.
4. Push the cards into the printer until they stop.
5. Slide the paper guide firmly against the edge of the cards.
6. Open the **Printer Properties** dialog box.
7. Click the **Features** tab, and then specify the following print settings:
   - **Print Quality**: Normal
   - **Paper Type**: Click More, and then select an appropriate card type.
   - **Size**: An appropriate card size
8. Select any other print settings that you want, and then click **OK**.

**Print booklets**
1. Slide the paper guide all the way to the left.
2. Place plain paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.
5. Open the **Printer Properties** dialog box.
6. Click the **Printing Shortcuts** tab.
7. In the **Printing Shortcuts** list, click **Booklet Printing**.
8. In the **Print On Both Sides** drop-down list, select one of the following binding options:
   - **Left Edge Booklet**
   - **Right Edge Booklet**
9. Select any other print settings that you want, and then click **OK**.
10. When prompted, reload the printed pages in the paper tray as shown below.
11. Click **Continue** to finish printing the booklet.

**Print posters**
1. Slide the paper guide all the way to the left.
2. Place plain paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.

5. Open the **Printer Properties** dialog box.
6. Click the **Features** tab, and then specify the following print settings:
   • **Paper Type**: Plain Paper
   • **Orientation**: Portrait or Landscape
   • **Size**: An appropriate paper size
7. Click the **Advanced** tab, and then click **Printer Features**.
8. In the **Poster Printing** drop-down list, select the number of sheets for the poster.
9. Click the **Select Tiles** button.
10. Check that the number of tiles that are selected matches the number of sheets for the poster, and then click **OK**.
11. Select any other print settings that you want, and then click OK.

Print iron-on transfers
1. Slide the paper guide all the way to the left.
2. Place the iron-on transfer paper in the right side of the tray. The side to be printed on should face down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.
5. Open the Printer Properties dialog box.
6. Click the **Features** tab, and then specify the following print settings:
   • **Print Quality**: Normal or Best
   • **Paper Type**: Click More, click Specialty Papers, and then click Other specialty paper.
   • **Size**: An appropriate paper size

7. Click the **Advanced** tab.

8. Click **Printer Features**, and then set **Mirror Image** to **On**.

   **NOTE:** Some iron-on transfer software programs do not require you to print a mirror image.

9. Select any other print settings that you want, and then click **OK**.

**Related topics**
- “Recommended papers for printing” on page 21
- “Load media” on page 23
- “Use printing shortcuts” on page 19
- “Set the default print settings” on page 20
- “Stop the current job” on page 55

**Print a Web page**

You can print a Web page from your Web browser on the HP All-in-One.

If you use Internet Explorer (6.0 or higher) or Firefox (2.0 or higher) for Web browsing, you can use HP **Smart Web Printing** to ensure simple, predictable web printing with control over what you want and how you want it printed. You can access HP **Smart Web Printing** from the toolbar in Internet Explorer. For more information about HP **Smart Web Printing**, see the help file provided with it.

**To print a Web page**

1. Make sure you have paper loaded in the input tray.

2. On the **File** menu in your Web browser, click **Print**.

   **TIP:** For best results, select **HP Smart Web Printing** on the **File** menu. A check mark appears when it is selected.

   The **Print** dialog box appears.

3. Make sure the product is the selected printer.

4. If your Web browser supports it, select the items on the Web page that you want to include in the printout.

   For example, in Internet Explorer, click the **Options** tab to select options such as **As laid out on screen**, **Only the selected frame**, and **Print all linked documents**.

5. Click **Print** or **OK** to print the Web page.

   **TIP:** To print Web pages correctly, you might need to set your print orientation to **Landscape**.
Print using the maximum dpi

Use maximum dpi mode to print high-quality, sharp images.

To get the most benefit from maximum dpi mode, use it to print high-quality images such as digital photographs. When you select the maximum dpi setting, the printer software displays the optimized dots per inch (dpi) that the HP All-in-One printer will print. Printing in maximum dpi is supported on the following paper-types only:

- HP Premium Plus Photo Paper
- HP Premium Photo Paper
- HP Advanced Photo Paper
- Photo Hagaki

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

To print in Maximum dpi mode
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
5. Click the Advanced tab.
6. In the Printer Features area, select Enabled from the Maximum dpi drop-down list.
7. Click the Features tab.
8. In the Paper Type drop-down list, click More, and then select the appropriate paper type.
9. In the Print Quality drop-down list, click Maximum dpi.

NOTE: To view the maximum dpi that the product will print, click Resolution.

10. Select any other print settings that you want, and then click OK.

Related topics
“View the print resolution” on page 19
View the print resolution

The printer software displays the print resolution in dots per inch (dpi). The dpi varies according to the paper type and print quality that you select in the printer software.

To view the print resolution
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Print Quality drop-down list, select the appropriate print quality setting for your project.
7. In the Paper Type drop-down list, select the type of paper that you have loaded.
8. Click the Resolution button to view the print resolution dpi.

Use printing shortcuts

Use printing shortcuts to print with print settings that you use often. The printer software has several specially designed printing shortcuts that are available in the Printing Shortcuts list.

NOTE: When you select a printing shortcut the appropriate printing options are automatically displayed. You can leave them as is, change them, or create your own shortcuts for commonly used tasks.

Use the Printing Shortcuts tab for the following print tasks:

- **General Everyday Printing**: Print documents quickly.
- **Paper-saving Printing**: Print two-sided documents with multiple pages on same sheet to reduce paper usage.
- **Photo Printing—With White Borders**: Print a photo with a white border around the edges.
- **Fast/Economical Printing**: Produce draft-quality printouts quickly.
- **Presentation Printing**: Print high-quality documents, including letters and transparencies.

To create a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.
3. Click the button that opens the Properties dialog box.
   Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the **Printing Shortcuts** list, click a printing shortcut. The print settings for the selected printing shortcut are displayed.

6. Change the print settings to those you want in the new printing shortcut.

7. Click **Save as** and type a name for the new printing shortcut, and then click **Save**. The printing shortcut is added to the list.

**To delete a printing shortcut**

1. On the **File** menu in your software application, click **Print**.
2. Make sure the product is the selected printer.
3. Click the button that opens the **Properties** dialog box. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer**, or **Preferences**.
4. Click the **Printing Shortcuts** tab.
5. In the **Printing Shortcuts** list, click the printing shortcut that you want to delete.
6. Click **Delete**. The printing shortcut is removed from the list.

![**NOTE:** Only the shortcuts that you have created can be deleted. The original HP shortcuts cannot be deleted.](image)

---

**Set the default print settings**

If there are settings that you frequently use for printing, you might want to make them the default print settings so they are already set when you open the **Print** dialog box from within your software application.

**To change the default print settings**

1. In the HP Solution Center, click **Settings**, point to **Print Settings**, and then click **Printer Settings**.
2. Make changes to the print settings, and click **OK**. 
4 Paper basics

You can load many different types and sizes of paper in the HP All-in-One, including letter or A4 paper, photo paper, transparencies, and envelopes.

This section contains the following topics:

“Load media” on page 23

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch) (with or without tabs). For longer-lasting photos, it is acid-free.

HP Brochure Paper or HP Superior Inkjet Paper
These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

HP Premium Presentation Paper or HP Professional Paper
These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavyweight for an impressive look and feel.

HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

HP Printing Paper
HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose or copy
paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

**HP Office Paper**

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

**HP Iron-On Transfers**

HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos.

**HP Premium Inkjet Transparency Film**

HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This film is easy to use and handle and dries quickly without smudging.

**HP Photo Value Pack**

HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save you time and take the guesswork out of printing affordable professional photos with your HP All-in-One. Original HP inks and HP Advanced Photo Paper have been designed to work together so your photos are long lasting and vivid, print after print. Great for printing out an entire vacation’s worth of photos or multiple prints to share.

**ColorLok**

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

---

**NOTE:** At this time, some portions of the HP Web site are available in English only.

To order HP papers and other supplies, go to [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies). If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.
Load media

▲ Select a paper size to continue.

Load small-size paper
a. Slide paper-width guide to the left.
   Slide paper-width guide to the left.

b. Load paper.
   Insert stack of photo paper into photo tray with short edge forward and print side down.
   Slide stack of paper forward until it stops.
   **NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs are closest to you.
   Slide paper-width guide to the right until it stops at edge of paper.

Load full-size paper
a. Slide paper-width guide to the left
   Slide paper-width guide to the left.
b. **Load paper.**  
Insert stack of paper into input tray with short edge forward and print side down.

Slide stack of paper forward until it stops.  
Slide paper-width guide to the right until it stops at edge of paper.

**Load envelopes**  
a. **Slide paper-width guide to the left.**  
Slide paper-width guide to the left.
Remove all paper from the main input tray.

b. Load envelopes.

Insert one or more envelopes into far-right side of the input tray, with envelope flaps on left and facing up.

Slide stack of envelopes forward until it stops.

Slide paper-width guide to the right against stack of envelopes until it stops.

![Diagram of printer with envelope in input tray]
5 Scan

• Scan to a computer

Scan to a computer

NOTE: To scan to a computer, the HP All-in-One and computer must be connected and turned on. The HP Photosmart Software must also be installed and running on your computer prior to copying.

▲ To scan to a computer:

Single page scan

a. Load original.

   Lift lid on product.

Load original print side down on right front corner of glass.
Close lid.

b. Start scan.
   Start the **Scan** job using the HP Photosmart Software.

c. Preview and accept.
   Preview the scanned image and accept.

**Related topics**

“*Stop the current job*” on page 55
6 Copy

“Copy documents or photos” on page 29

Copy documents or photos

NOTE: To make copies, the HP All-in-One and computer must be connected and turned on. The HP Photosmart Software must also be installed and running on your computer prior to copying.

NOTE: Enlarge and reduce copy functionality is not available on all models.

▲ Do one of the following:

1-sided original to 1-sided copy

a. Load paper.
   Load either small photo paper or full-size paper in the main input tray.

b. Load original.
   Lift lid on product.

Load original print side down on right front corner of glass.
Close lid.

c. Start copy.
   Press either **Start Copy Black** or **Start Copy Color**.

**Related topics**

“Stop the current job” on page 55
7 Work with cartridges

- **Check the estimated ink levels**
- **Order ink supplies**
- **Automatically clean print cartridges**
- **Manually clean print cartridges**
- **Replace the cartridges**
- **Use ink-backup mode**
- **Cartridge warranty information**

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink supply level shows an estimate of the amount of ink remaining in the cartridges.

**NOTE:** If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.

**NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not have to replace the cartridges until the print quality is unacceptable.

**NOTE:** Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see [www.hp.com/go/inkusage](http://www.hp.com/go/inkusage).

To check the ink levels from the HP Photosmart Software

▲ In the HP Solution Center, click the **Estimated Ink Levels** icon.

**NOTE:** You can also open the **Printer Toolbox** from the **Print Properties** dialog box. In the **Print Properties** dialog box, click the **Features** tab, and then click the **Printer Services** button.

Related topics

“**Order ink supplies**” on page 31

Order ink supplies

For a list of cartridge numbers, use the software that came with the HP All-in-One to find out the reorder number.
Find the cartridge number

1. In the HP Solution Center, click **Settings**, point to **Print Settings**, and then click **Printer Toolbox**.

   **NOTE:** You can also open the **Printer Toolbox** from the **Print Properties** dialog box. In the **Print Properties** dialog box, click the **Features** tab, and then click the **Printer Services** button.

   The **Printer Toolbox** appears.

2. Click the **Estimated Ink Level** tab.

   The estimated ink levels for the print cartridges appear. Use the menu at the bottom to select **Cartridge details**.

To order genuine HP supplies for the HP All-in-One, go to [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies). If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

   **NOTE:** Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

To order ink cartridges from your desktop

To learn which HP supplies work with your printer, order supplies online, or create a printable shopping list, open HP Solution Center and select the online shopping feature.

Cartridge information and links to online shopping also appear on ink alert messages. In addition, you can find cartridge information and order online by visiting [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies).

   **NOTE:** Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

Related topics

“Choose the right cartridges” on page 32

Choose the right cartridges

HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP printers to help you easily produce great results, time after time.

Related topics

“Order ink supplies” on page 31

Automatically clean print cartridges

If your printed pages are faded or if they contain ink streaks, the print cartridges might be low on ink or might need to be cleaned. For more information, see “Check the estimated ink levels” on page 31.

If the print cartridges are not low on ink, clean the print cartridges automatically.
CAUTION: Clean print cartridges only when necessary. Unnecessary cleaning wastes ink and shortens the life of the cartridge.

To clean the print cartridges
1. In the HP Solution Center, click Settings. In the Print Settings area, click Printer Toolbox.
2. Click Clean the Print Cartridges.
3. Click Clean, and then follow the onscreen instructions.

Manually clean print cartridges

Make sure you have the following materials available:

- Dry foam rubber swabs, lint-free cloth, or any soft material that will not come apart or leave fibers.

Tips:
- Coffee filters are lint-free and work well for cleaning print cartridges.
- Distilled, filtered, or bottled water (tap water might contain contaminants that can damage the print cartridges).

CAUTION: Do not use platen cleaners or alcohol to clean the print cartridge contacts. These can damage the print cartridge or the product.

To clean the print cartridge contacts
1. Turn on the product and open the print cartridge door. The print carriage moves to the center of the product.
2. Wait until the print carriage is idle and silent, and then unplug the power cord from the back of the product.
3. Lightly press down on the print cartridge to release it, and then pull it towards you out of the slot.

Tips:
- Do not remove both print cartridges at the same time. Remove and clean each print cartridge one at a time. Do not leave a print cartridge outside the HP All-in-One for more than 30 minutes.

4. Inspect the print cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze any excess water from it.
6. Hold the print cartridge by its sides.
7. Clean only the copper-colored contacts. Allow the print cartridges to dry for approximately ten minutes.
8. Hold the print cartridge with the HP logo on top, and insert the print cartridge back into the slot. Make sure you push the print cartridge in firmly until it snaps into place.

9. Repeat if necessary for the other print cartridge.
10. Gently close the print cartridge door and plug the power cord into the back of the product.

Replace the cartridges

To replace the cartridges
1. Check power.
2. Remove cartridge.
   a. Open cartridge door.
Wait for print carriage to move to center of the product.

b. Press down to release cartridge, then remove it from slot.

3. Insert new cartridge.
   a. Remove cartridge from packaging.

b. Remove plastic tape using pink pull tab.

c. Line up colored shaped icons, then slide cartridge into slot until it clicks into place.
d. Close cartridge door.

4. Align cartridges.

Related topics
• “Choose the right cartridges” on page 32
• “Order ink supplies” on page 31

Use ink-backup mode

Use the ink-backup mode to operate the HP All-in-One with only one print cartridge. The ink-backup mode is initiated when a print cartridge is removed from the print cartridge carriage. During ink-backup mode, the product can only print jobs from the computer.

**NOTE:** When the HP All-in-One operates in ink-backup mode, a message is displayed on screen. If the message is displayed and two print cartridges are installed in the product, verify that the protective piece of plastic tape has been removed from each print cartridge. When plastic tape covers the print cartridge contacts, the product cannot detect that the print cartridge is installed.

Exit ink-backup mode

Install two print cartridges in the HP All-in-One to exit ink-backup mode.

Related topics
“Replace the cartridges” on page 34

Cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the product.
8 Solve a problem

This section contains the following topics:

- HP support
- Setup troubleshooting
- Print troubleshooting
- Scan troubleshooting
- Copy troubleshooting
- Errors

HP support

- Support process
- HP support by phone
- Additional warranty options

Support process

If you have a problem, follow these steps:

1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP customers. It is the fastest source for up-to-date product information and expert assistance and includes the following features:
   - Fast access to qualified online support specialists
   - Software and driver updates for the product
   - Valuable product and troubleshooting information for common problems
   - Proactive product updates, support alerts, and HP newsgrams that are available when you register the product
3. Call HP support. Support options and availability vary by product, country/region, and language.

HP support by phone

Phone support options and availability vary by product, country/region, and language.

This section contains the following topics:

- Phone support period
- Placing a call
- Support phone numbers
- After the phone support period

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support. Standard phone company charges apply.
Placing a call

Call HP support while you are in front of the computer and the product. Be prepared to provide the following information:

• Product name (HP Deskjet F2400 All-in-One series)
• Serial number (located on the back or bottom of the product)
• Messages that appear when the situation occurs
• Answers to these questions:
  ◦ Has this situation happened before?
  ◦ Can you re-create it?
  ◦ Did you add any new hardware or software to your computer at about the time that this situation began?
  ◦ Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options

Extended service plans are available for the HP All-in-One at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.

Setup troubleshooting

This section contains setup troubleshooting information for the product.

Many issues are caused when the product is connected to the computer using a USB cable before the HP Photosmart software is installed on the computer. If you connected the product to your computer before the software installation screen prompts you to do so, you must follow these steps:

Troubleshooting common setup issues

1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
   For more information, see “Uninstall and reinstall the software” on page 43.
3. Restart your computer.
4. Turn off the product, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.
CAUTION: Do not connect the USB cable to the computer until prompted by the software installation screen.

This section contains the following topics:

• The product will not turn on
• After setting up the product, it does not print
• The registration screen does not appear
• Uninstall and reinstall the software

The product will not turn on

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

• Solution 1: Make sure the power cord is connected
• Solution 2: Press the On button more slowly

Solution 1: Make sure the power cord is connected

Solution:

• Make sure the power cord is firmly connected to both the product and the power adapter. Plug the power cord into a power outlet, surge protector, or power strip.

• If you are using a power strip, make sure the power strip is on. Or, try plugging the product directly into a power outlet.
• Test the power outlet to make sure it is working. Plug in an appliance that you know works, and see if the appliance has power. If not, then there might be a problem with the power outlet.
• If you plugged the product into a switched outlet, make sure the outlet is switched on. If it is switched to on but still does not work, then there might be a problem with the power outlet.

**Cause:** The product was not properly connected to a power supply.

If this did not solve the issue, try the next solution.

---

### Solution 2: Press the On button more slowly

**Solution:** The product might not respond if you press the On button too quickly. Press the On button once. It might take a few minutes for the product to turn on. If you press the On button again during this time, you might turn the product off.

⚠️ **CAUTION:** If the product still does not turn on, it might have a mechanical failure. Unplug the product from the power outlet.

Contact HP support for service.

Go to: [www.hp.com/support](http://www.hp.com/support). If prompted, choose your country/region, and then click **Contact HP** for information on calling for technical support.

**Cause:** You pressed the On button too quickly.

---

### After setting up the product, it does not print

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

- **Step 1: Press the On button to turn on the product**
- **Step 2: Set your product as the default printer**
- **Step 3: Check the connection between the product and computer**

#### Step 1: Press the On button to turn on the product

**Solution:** Look at the On button located on the product. If it is not lit, the product is turned off. Make sure the power cord is firmly connected to the product and plugged into a power outlet. Press the On button to turn on the product.

**Cause:** The product might not have been turned on.

If this did not solve the issue, try the next solution.

---

#### Step 2: Set your product as the default printer

**Solution:** Use the system tools on your computer to change your product to be the default printer.
**Cause:** You sent the print job to the default printer, but this product was not the default printer.

If this did not solve the issue, try the next solution.

---

**Step 3: Check the connection between the product and computer**

**Solution:** Check the connection between the product and computer.

**Cause:** The product and computer were not communicating with each other.

If this did not solve the issue, try the next solution.

---

**The registration screen does not appear**

**Solution:** You can access the registration (Sign up now) screen from the Windows taskbar by clicking Start, pointing to Programs or All Programs, HP, Deskjet F2400 All-in-One series, and then clicking Product Registration.

**Cause:** The registration screen did not launch automatically.

---

**Uninstall and reinstall the software**

If your installation is incomplete, or if you connected the USB cable to the computer before prompted by the software installation screen, you might need to uninstall and then reinstall the software. Do not simply delete the HP All-in-One application files from your computer. Make sure to remove them properly using the uninstall utility provided when you installed the software that came with the HP All-in-One.

**To uninstall and reinstall the software**

1. On the Windows taskbar, click Start, Settings, Control Panel (or just Control Panel).
2. Double-click Add/Remove Programs (or click Uninstall a program).
3. Select HP Photosmart All-In-One Driver Software, and then click Change/Remove.
   - Follow the onscreen instructions.
4. Disconnect the product from your computer.
5. Restart your computer.

**NOTE:** It is important that you disconnect the product before restarting your computer. Do not connect the product to your computer until after you have reinstalled the software.
6. Insert the product CD-ROM into your computer's CD-ROM drive and then start the Setup program.

**NOTE:** If the Setup program does not appear, locate the setup.exe file on the CD-ROM drive and double-click it.

**NOTE:** If you no longer have the installation CD, you can download the software from [www.hp.com/support](http://www.hp.com/support).

7. Follow the onscreen instructions and the instructions provided in the printed documentation that came with the product.

When the software installation is complete, the **HP Digital Imaging Monitor** icon appears in the Windows system tray.

---

**Print troubleshooting**

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

- Check cartridges
- Check paper
- Check product
- Check printer settings
- Reset the product
- Contact HP support

**Check cartridges**

Try the following solutions.

- **Step 1: Make sure you are using genuine HP ink cartridges**
Step 1: Make sure you are using genuine HP ink cartridges

**Solution:** Check to see if your ink cartridges are genuine HP ink cartridges. HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges are designed and tested with HP printers to help you easily produce great results, time after time.

**NOTE:** HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

**Cause:** Non-HP ink cartridges were being used.

If this did not solve the issue, try the next solution.

Step 2: Check the ink levels

**Solution:** Check the estimated ink levels in the cartridges.

**NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes unacceptable.

For more information, see:

“Check the estimated ink levels” on page 31

**Cause:** The ink cartridges might have insufficient ink.

If this did not solve the issue, try the next solution.

Check paper

Try the following solutions.

• **Step 1: Make sure only one type of paper is loaded**

• **Step 2: Load the stack of paper correctly**

Step 1: Make sure only one type of paper is loaded

**Solution:** Load only one type of paper at a time.

**Cause:** More than one type of paper was loaded in the input tray.

If this did not solve the issue, try the next solution.
Step 2: Load the stack of paper correctly

**Solution:** Remove the stack of paper from the input tray, reload the paper, and then slide the paper width guide inward until it stops at the edge of the paper.

For more information, see: “Load media” on page 23

**Cause:** The paper guides were not positioned correctly.

---

Check product

Try the following solutions.

- **Solution 1: Align the print cartridges**
- **Solution 2: Automatically clean the print cartridges.**

**Solution 1: Align the print cartridges**

**Solution:** Aligning the print cartridges can help ensure high-quality output.

To align the print cartridges from the HP Photosmart Software

1. Load letter or A4 unused plain white paper into the paper tray.
2. In the HP Solution Center, click **Settings**.
3. In the **Print Settings** area, click **Printer Toolbox**.

   **NOTE:** You can also open the **Printer Toolbox** from the **Print Properties** dialog box. In the **Print Properties** dialog box, click the **Features** tab, and then click **Printer Services**.

   The **Printer Toolbox** appears.

4. Click the **Device Services** tab.
5. Click **Align the Print Cartridges**.
6. Click **Align**, and then follow the onscreen instructions.

   The HP All-in-One prints a test page, aligns the print cartridges, and calibrates the printer. Recycle or discard the test page.

   **Cause:** The printer needed to be aligned.

   If this did not solve the issue, try the next solution.

---

**Solution 2: Automatically clean the print cartridges.**

**Solution:** Clean the print cartridges.

For more information, see “Automatically clean print cartridges” on page 32

**Cause:** The print cartridge nozzles needed to be cleaned.

If this did not solve the issue, try the next solution.
Check printer settings

Try the following solutions.

- **Step 1: Check the print settings**
- **Step 2: Verify the paper size setting**
- **Step 3: Check the printer margins**

**Step 1: Check the print settings**

**Solution:** Check the print settings.
- Check the print settings to see if the color settings are incorrect. For example, check to see if the document is set to print in grayscale. Or, check to see if advanced color settings such as saturation, brightness, or color tone, are set to modify the appearance of colors.
- Check the print quality setting and make sure it matches the type of paper loaded in the product.
  
  You might need to choose a lower print quality setting, if colors are running into each other. Or, choose a higher setting if you are printing a high-quality photo, and then make sure photo paper such as HP Advanced Photo Paper, is loaded in the input tray.

**NOTE:** On some computer screens, colors might appear differently than they do when printed on paper. In this case, there is nothing wrong with the product, print settings, or ink cartridges. No further troubleshooting is required.

**Cause:** The print settings were set incorrectly.

If this did not solve the issue, try the next solution.

**Step 2: Verify the paper size setting**

**Solution:** Verify that you have selected the proper paper size setting for your project. Make sure that you have loaded the correct paper size in the input tray.

**Cause:** The paper size setting might not have been set correctly for the project you were printing.

If this did not solve the issue, try the next solution.

**Step 3: Check the printer margins**

**Solution:** Check the printer margins.
Make sure the margin settings for the document do not exceed the printable area of the product.

**To check your margin settings**

1. Preview your print job before sending it to the product. In most software applications, click the **File** menu, and then click **Print Preview**.
2. Check the margins. The product uses the margins you have set in your software application, as long as they are greater than the minimum margins the product supports. For more information about setting margins in your software application, see the documentation that came with the software.
3. Cancel the print job if the margins are not satisfactory, and then adjust the margins in your software application.

**Cause:** The margins were not set correctly in your software application.

If this did not solve the issue, try the next solution.

---

**Reset the product**

**Solution:** Turn off the product, and then unplug the power cord. Plug the power cord back in, and then press the **On** button to turn on the product.

**Cause:** The product experienced an error.

If this did not solve the issue, try the next solution.

---

**Contact HP support**

**Solution:** Contact HP support for service.

Go to: [www.hp.com/support](http://www.hp.com/support).

If prompted, choose your country/region, and then click **Contact HP** for information on calling for technical support.

**Cause:** The ink cartridges were not intended for use in this product.

---

**Scan troubleshooting**

Use this section to solve these scan problems:

- **Scanned image is incorrectly cropped**
- **Scanned image shows dotted lines instead of text**
- **Text format is incorrect**
- **Text is incorrect or missing**

**Scanned image is incorrectly cropped**

**Solution:** The autocropping feature in the HP Solution Center software crops anything that is not part of the main image. Sometimes this might not be what you
want. In that case, turn off autocropping in the HP Solution Center software and crop the scanned image manually, or not at all.

**Cause:** The software was set to automatically crop scanned pictures.

---

**Scanned image shows dotted lines instead of text**

**Solution:** Make a black-and-white copy of the original and then scan the copy.

**Cause:** If you used the Text image type to scan text that you planned to edit, the scanner might not have recognized color text. The Text image type scans at 300 x 300 dpi, in black and white.

If you scanned an original that has graphics or artwork surrounding the text, the scanner might not have recognized the text.

---

**Text format is incorrect**

**Solution:** Some applications cannot handle framed text formatting. Framed text is one of the scan document settings in the software. It maintains complex layouts, such as multiple columns from a newsletter, by putting the text in different frames (boxes) in the destination application. In the software, select the correct format so that the scanned text layout and formatting are retained.

**Cause:** The scan document settings were incorrect.

---

**Text is incorrect or missing**

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

- **Solution 1: Adjust the brightness in the software**
- **Solution 2: Clean the glass and lid**

**Solution 1: Adjust the brightness in the software**

**Solution:** Adjust the brightness in the software, and then rescan the original.

**Cause:** The brightness was not set correctly.

If this did not solve the issue, try the next solution.

---

**Solution 2: Clean the glass and lid**

**Solution:** Turn off the product, unplug the power cord, and use a soft cloth to wipe the glass and the back of the document lid.

**Cause:** Debris might have been stuck on the glass or on the back of the document lid. This can cause poor-quality scans.
Copy troubleshooting

Use this section to solve these copy problems:

- Parts of the original do not appear or are cut off
- The printout is blank

Parts of the original do not appear or are cut off

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

- Solution 1: Place the original correctly on the glass
- Solution 2: Clean the scanner glass

Solution 1: Place the original correctly on the glass

Solution: Load your original print side down on the right front corner of the glass.

Cause: The original was placed incorrectly on the glass.

If this did not solve the issue, try the next solution.

Solution 2: Clean the scanner glass

Solution: Clean the scanner glass and make sure that there are no foreign materials adhering to it.

Cause: The scanner glass was dirty, causing the product to include an area in the copy that was larger than the document.

The printout is blank

Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.
• **Solution 1: Place the original correctly on the glass**

  **Solution:** Load your original print side down on the right front corner of the glass.

  **Cause:** The original was placed incorrectly on the glass. If this did not solve the issue, try the next solution.

• **Solution 2: Check the ink levels in the print cartridges**

  **Solution:** Check the estimated ink levels remaining in the print cartridges.

  **NOTE:** Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the print cartridges until print quality becomes unacceptable.

  If there is ink remaining in the print cartridges, but you are still noticing a problem, print a self-test report to determine if there is a problem with the print cartridges. If the self-test report shows a problem, clean the print cartridges. If the problem persists, you might need to replace the print cartridges.

  **Cause:** The print cartridges needed to be cleaned or there was insufficient ink.

## Errors

This section contains the following categories of messages about your product:

• **Flashing lights**
• **Printing in ink-backup mode**
### Flashing lights

The lights on the product flash in special sequences to inform you about various error conditions. Refer to the following table for information on solving your error condition based on which lights are on or flashing on the product.

<table>
<thead>
<tr>
<th>On light</th>
<th>Attention light</th>
<th>Ink attention lights</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>The product is turned off.</td>
<td>Press the On button to turn the product on.</td>
</tr>
<tr>
<td>Blinking</td>
<td>Off</td>
<td>Off</td>
<td>The product is processing a job.</td>
<td>Wait for the product to finish.</td>
</tr>
<tr>
<td>On</td>
<td>Fast blinking</td>
<td>On</td>
<td>The tape was not removed from one or both print cartridges.</td>
<td>Remove the print cartridge, remove tape, and reinsert the print cartridge.</td>
</tr>
<tr>
<td>On</td>
<td>Fast blinking</td>
<td>Off</td>
<td>The product is out of paper. The product has a paper jam.</td>
<td>Load paper and press any button to continue.</td>
</tr>
<tr>
<td></td>
<td>Fast blinking</td>
<td>Off</td>
<td>The front access door or the print cartridge access door is open.</td>
<td>Close the front access door or the print cartridge access door.</td>
</tr>
<tr>
<td>On</td>
<td>Fast blinking</td>
<td>Fast blinking</td>
<td>The print cartridges are missing or not seated correctly.</td>
<td>Install or remove and reinsert print cartridges. For information about manually cleaning the print cartridges, see &quot;Manually clean print cartridges&quot; on page 33.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The print cartridge might be defective.</td>
<td>Remove the print cartridge, remove tape, and reinsert the print cartridge.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The tape was not removed from one or both print cartridges.</td>
<td>The print cartridge might not be supported for use in the product. For more information about compatible print cartridges, see &quot;Order ink supplies&quot; on page 31.</td>
</tr>
<tr>
<td>On</td>
<td>Fast blinking</td>
<td>Both fast blinking</td>
<td>The print carriage is stalled.</td>
<td>Open the front access door, and</td>
</tr>
<tr>
<td>On light</td>
<td>Attention light</td>
<td>Ink attention lights</td>
<td>Description</td>
<td>Solution</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>----------------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Fast blinking | Fast blinking | Both fast blinking | The product has a fatal error. | 1. Turn off the product.  
2. Unplug the power cord.  
3. Wait a minute, then plug the power cord back in.  
4. Turn on the product.  
If the problem persists, contact HP Support. |
| On | Off | On | Print cartridge(s) are getting low on ink. | Replace one or both print cartridges when print quality is no longer acceptable. |
| On | Off | Tri-color print cartridge light On  
Black print cartridge light Off | The tri-color print cartridge is getting low on ink.  
The tri-color print cartridge has been removed. | Replace the tri-color print cartridge when print quality is no longer acceptable.  
Replace the tri-color print cartridge, or print in ink-backup mode with the black print cartridge. For more information, see “Printing in ink-backup mode” on page 54. |
| On | Off | Tri-color print cartridge light Off  
Black print cartridge light On | The black print cartridge is getting low on ink.  
The black print cartridge has been removed. | Replace the black print cartridge when print quality is no longer acceptable.  
Replace the black print cartridge, or print in ink-backup mode with the tri-color print cartridge. For more information, see “Printing in ink-backup mode” on page 54. |
Printing in ink-backup mode

Solution: If you receive the ink-backup mode message and two print cartridges are installed in the product, verify that the protective piece of plastic tape has been removed from each print cartridge. When plastic tape covers the print cartridge contacts, the product cannot detect that the print cartridge is installed.

1. Copper-colored contacts
2. Plastic tape with pink pull tab (must be removed before installing)
3. Ink nozzles under tape

Cause: When the product detected that only one print cartridge is installed, ink-backup mode is initiated. This printing mode lets you print with a single print cartridge, but it slows the product and affects the quality of printouts.
9 Stop the current job

To stop a print job from the HP All-in-One

▲ Press Cancel on the control panel. If the print job does not stop, press Cancel again. It can take a few moments for printing to be cancelled.
10 Technical information

The technical specifications and international regulatory information for the HP All-in-One are provided in this section.
For additional specifications, see the printed documentation that came with the HP All-in-One.
This section contains the following topics:

• Notice
• Specifications
• Environmental product stewardship program
• Regulatory notices

Notice

Hewlett-Packard Company notices

The information contained in this document is subject to change without notice.
All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission of Hewlett-Packard, except as allowed under copyright laws. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
© 2009 Hewlett-Packard Development Company, L.P.
Windows Vista is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Specifications

Technical specifications for the HP All-in-One are provided in this section. For complete product specifications, see the Product Data Sheet at www.hp.com/support.

System requirements
Software and system requirements are located in the Readme file.
For information about future operating system releases and support, visit the HP online support Web site at www.hp.com/support.

Environmental specifications

• Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)
• Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)
• Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
• Non-operating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)
• In the presence of high electromagnetic fields, it is possible the output from the HP All-in-One may be slightly distorted
• HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields

Paper tray capacity
Plain paper sheets (75 g/m² [20 lb]): Up to 80
Envelopes: Up to 10
Index cards: Up to 30
Photo paper sheets: Up to 30
Paper size
For a complete list of supported media sizes, see the printer software.

Paper weights
Plain Paper: 75 to 90 g/m² (20 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75 lb)

Print specifications
• Print speeds vary according to the complexity of the document
• Panorama-size printing
• Method: drop-on-demand thermal inkjet
• Language: PCL3 GUI

Copy specifications
• Digital image processing
• Maximum number of copies varies by model
• Copy speeds vary according to the complexity of the document and model
• Maximum copy enlargement ranging from 200-400% (depends on model)
• Maximum copy reduction ranging from 25-50% (depends on model)
• Copy enlargement and reduction functionality not available on all models

Scan specifications
• Image editor included
• Twain-compliant software interface
• Resolution: up to 1200 x 2400 ppi optical (HP Deskjet F2420/2423 models up to 1200 x 1200 ppi)
  For more information about ppi resolution, see the scanner software.
• Color: 48-bit color, 8-bit grayscale (256 levels of gray)
• Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution
To find out about the printer resolution, see the printer software. For more information, see "View the print resolution" on page 19.

Cartridge yield
Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to: www.hp.com/support.

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment Web site at: www.hp.com/hpinfo/globalcitizenship/environment/index.html
This section contains the following topics:
Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Your product's Eco features
• **Smart Web printing**: The HP Smart Web Printing interface includes a **Clip Book** and **Edit Clips** window where you can store, organize, or print clips you have gathered from the Web. For more information, see “Print a Web page” on page 17.
• **Energy Savings information**: To determine the ENERGY STAR® qualification status for this product, see “Power consumption” on page 59.
• **Recycled Materials**: For more information regarding recycling of HP products, please visit: www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at: www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following Web site: www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption
Power usage drops significantly while in Sleep mode, which saves natural resources and saves money without affecting the high performance of this product. To determine the ENERGY STAR®
Disposal of Waste Equipment by Users in Private Households in the European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local government office, waste disposal service or the store where you purchased the product.

Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea

Este símbolo en el producto o en el embalaje indica que no se puede deshacer del producto junto con los residuos domésticos. En cambio, es responsabilidad del usuario entregarlo en un punto de recogida designado de reciclaje de residuos eléctricos y electrónicos. La recogida separada y reciclaje de los residuos domésticos al momento de deshacerse de ellos contribuirá a la conservación de los recursos naturales y al asegurar el reciclaje en un modo que proteja la salud humana y el medio ambiente. Para obtener más información sobre cómo puede deshacerse de los residuos domésticos, póngase en contacto con el gobierno local, el servicio de recogida de residuos o la tienda donde compró el producto.

Protestanje z odpadno opremo v gospodinjstvih znotraj Evropske unije

Ta simbol na proizvodu ali na paketovanju pomeni, da se ta proizvod ne sme izboljšati med druga domača odpadke. Vзамен, je vaše obveznost, da to proizvod izboljšate, vključno s elektronsko in električno opremo v odrejenem zbiralnem mestu za recikliranje odpadne električne in elektronske opreme. Samo izboljšanje in recikliranje odpadne električne in elektronske opreme na začetku prekinitve bo pomagalo učinkovito uporabi naravnih virov in zasnovano izboljšanje pri recikliranju, ki bo zagotovilo varnost ljudskih dobra in okolja. Za več informacij o zbiralnih mestih za recikliranje odpadne električne in elektronske opreme se obrnite na lokalno obdobje, pogosto predmeta o odpadkih ali poiščite lokalno zapadle za recikliranje odpadne električne in elektronske opreme.

Înlăturarea echipamentelor uzate de către utilizatorii casnici din Uniunea Europeană

Acest simbol pe produs sau pachetul lui indică faptul că produsul nu poate fi aruncat împreună cu cumpărații domolizite. Este responsabilitatea utilizatorului de a arunca produsul într-o punct de colectare următor de reciclare a echipamentelor electrice și electronice. Se va colecta și va recicla echipamentul electric și electronic la momentul arătării, pentru a conserva resursele naturale și asigura că este reciclat într-un mod care protejează sănătatea omului și mediul. Pentru mai multă informație despre locuri unde puteți depune echipamentele electronice și electrice, contactați autoritățile locale, serviciul de reciclare sau magazinul în locația unde ați achiziționat produsul.
Chemical Substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.

Regulatory notices

The HP All-in-One meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

• Regulatory model identification number
• FCC statement
• Notice to users in Korea
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about the power cord
• HP Deskjet F2400 All-in-One series declaration of conformity

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is SNPRH-0806. This regulatory number should not be confused with the marketing name (HP Deskjet F2400 All-in-One series, etc.) or product numbers (CB730A, etc.).
FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notice to users in Korea

B 급 기기(가정용 방송통신기기)

이 기기는 가정용(B급)으로 전자파적합등록을 한 기기로서 주 로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다.

VCCI (Class B) compliance statement for users in Japan

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準に基づくクラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると受信障害を引き起こすことがあります。

取り扱い説明書に従って正しい取り扱いをして下さい。
Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。
HP Deskjet F2400 All-in-One series declaration of conformity

DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

DoC #: SNPRH-0806

Supplier’s Name: Hewlett-Packard Company
Supplier’s Address: 20, Jia Feng Road Waigaoqiao Free Trade Zone Pudong, Shanghai, PRC

declares, that the product
Product Name and Model: HP Deskjet F2400 Series and HP Deskjet Ink Advantage AiO
Regulatory Model Number: SNPRH-0806
Product Options: All
Conforms to the following Product Specifications and Regulations:

EMC:
CISPR 22: 2005 / EN 55022: 2006 Class B
EN 61000-3-2: 2006
FCC CFR 47 Part 15 Class B / ICES-003, Issue 4 Class B

Safety:

Environment:
WEEE Directive 2002/96/EC
RoHS Directive 2002/95/EC

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
The product herewith complies with the requirements of the Low Voltage Directive 2006/95/EC, the EMC Directive 2004/108/EC, and carries the CE mark accordingly.

Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be confused with the marketing name or the product numbers.

23 Oct 2008

Peng Cong
IPMO (China) Product Regulations Manager

Local contact for regulatory topics only:
Index

A
after the support period 40

B
blank
copy 50

C
connection problems
HP All-in-One will not turn on 41
copy
blank 50
missing information 50
specifications 58
troubleshooting 50
customer support
warranty 40

E
environment
Environmental product stewardship program 58
environmental specifications 57
error messages 51

I
ink-backup mode 36

M
missing
information from copy 50
text from scan 49

P
paper
recommended types 21
phone support 39
phone support period
period for support 39
print
specifications 58
troubleshooting 44
printing with one print cartridge 36
problems
copy 50
error messages 51
print 44
scan 48
troubleshoot setup 40
troubleshooting
copy 50
error messages 51
print 44
scan 48

U
uninstall software 43

W
warranty 40

R
recycle
ink cartridges 59
regulatory notices
regulatory model identification number 61
reinstall software 43

S
scan
crop incorrect 48
scan specifications 58
text appears as dotted lines 49
text format incorrect 49
text incorrect 49
troubleshooting 48
software installation
reinstall 43
uninstall 43
start copy
black 6
color 6
support process 39
system requirements 57

t
technical information
copy specifications 58
environmental specifications 57
print specifications 58
scan specifications 58
system requirements 57
text
dotted lines on scan 49
incorrect format on scan 49
incorrect or missing on scan 49